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Introduction 
 
The practical contains two exercises related to earth observation of water resources.  

 

These exercises were developed originally for the ESA-MOST Dragon programme advanced 

training course in land remote sensing. 

 

Exercise1 deals with the preparation of MODIS Level 1B data as input for SEBS, which 

includes preparing software for reading MODIS products, ordering and downloading the 

MODIS Level_1B data, and viewing and getting familiar with the MODIS data products in 

HDF format. 

 

Exercise 2 will guide  you through the different steps in processing satellite data (e.g. MODIS 

Level-1B data) in the ILWIS system (Integrated Land and Water Information System, an 

open source Remote sensing and GIS system developed by ITC, University of Twente, 

downloadable from http://52north.org/downloads/category/10-ilwis). In a step by step 

procedure, this exercise enables you to derive land surface geophysical parameters and energy 

balance components, including evaporation rate. The processes are similar to many sensors, 

so the steps apply to high to medium and low resolution imagery (NOAA-AVHRR, MODIS, 

LandSat, ASTER, and others). The process consists of four main sub-processes: image 

(re)projection, image import, pre-processing, and the direct SEBS model application. 

The user is warned that despite that the whole process sequences is similar for different 

sensors, the methodology of pre-processing is different and needs to be adapted. The SEBS 

model process remains practically unaltered.         
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Exercise 1: Preparing MODIS data for SEBS  

 

Exercise Steps: 

 

 Preparing the software for MODIS products 

 Ordering and downloading the MODIS Level_1B data 

 Viewing and Getting familiar with the MODIS data products (HDF datasets) used in 

this exercise 

 

1.1 Preparing software for using MODIS products 

1.1.1 HDFView 

HDFView is a tool for browsing and viewing the contents of HDF files. The software can be 

downloaded from http://www.hdfgroup.org/hdf-java-html/hdfview/ 

 

If not installed already, install the package as follows: 

 

 Type hdfview_install_windows_novm.exe to install 

 Start from Start -> programs -> HDFView 2.8 -> HDFView 2.8  

 

Note: Before the installation of the software, Java JDK1.5.0 (or higher) must be installed on 

your machine. 

1.1.2 ModisSwathTool 

 

The Modis Reprojection Tool Swath allows you to reproject swath MODIS level-1 and  level-

2 data products. It is free and can be obtained from the internet link below: 

https://lpdaac.usgs.gov/tools/modis_reprojection_tool 

 

In this exercise, the software MRTSwath.zip has been downloaded and provided.  

 

First unzip the MRTSwath.zip file to a folder, for example, D:\MRTSwath directory. Next 

you need to edit the ModisSwathTool.bat file in D:\MRTSwath\bin directory. You will need 

to update the MRTDATADIR to the MRTSwath data directory, the path to the Java 

executable, and the path to the ModisSwathTool.jar file. For example, the Java executable 

path is C:\Program Files\Java\jre1.5.0_11\bin, and the MRTSwath is installed in the 

D:\MRTSwath directory, the sample ModisSwathTool.bat file should look like as follows: 

  

 set MRTDATADIR=D:\MRTSwath\data 

 "c:\WINDOWS\system32\java.exe" –classpath 

"D:\MRTSwath\bin\ModisSwathTool.jar" mrtswath.ModisSwathTool  

mrtswath.ModisSwathTool 

 

Note that the blue statement starting with “c\windows…” is all on one line. Do 

not break this statement into multiple lines! 

Also note that The MRTSwath will not run correctly if the installation uses directory 

names that include blank spaces.  

 

Start MRTSwath with ModisSwathTool.bat from the D:\MRTSwath\bin directory, or to 

create a shortcut to MRTSwath, and click on the shortcut. 

http://www.hdfgroup.org/hdf-java-html/hdfview/
https://lpdaac.usgs.gov/tools/modis_reprojection_tool
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1.2 Ordering and downloading the MODIS data 

 

For this exercise, you will be using the following MODIS products, covering the Naqu site on 

the Tibetan plateau, China: 

 

MODIS calibrated L1B swath product named as: 

MOD021KM.A2008186.0430.005.2010188194504.hdf  

And its corresponding geolocation L1A product: 

MOD03.A2008186.0430.005.2008186113434.hdf  

 

Corresponding to an overpass on July 4, 2008 (Julian day186), recorded at 04:30 GMT.  

 

You can order these products from the NASA’s LAADS Web site: 

http://ladsweb.nascom.nasa.gov/browse_images 

   

 

 
 

Figure 1.1 Overview of the web page for MODIS data downloads 

 

  

For downloading MODIS L1B product, clicking on DATA field, then clicking on 

Search for MODIS level 1, atmosphere and land products. 
 

The page that corresponds to this selection is shown in the picture below:   
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Figure 1.2 Overview of MODIS data search 

 

Select the following options for: 

 

Satellite/Instrument: 

 Terra MODIS     

 

 Group: 

 Terra Level 1 Products 

   

Products 

MOD021KM – Level 1B Calibrated Radiances – 1km  

MOD03 – Geolocation – 1km 

 

Search Date and Time 

Start Date and Time: 04/07/2008 Time (UTC): 04:00:00  

End Date and Time:   04/07/2008 Time (UTC): 05:00:00 

 

Collection: 

6 – Modis Collection 6 – L1, Atmos and Land  

 

Special Selection 

Latitude/Longitude 

 

Search Area 

Type in Lat/Lon range 

Northern latitude: 35 

Southern latitude: 27 

West longitude: 86 
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East longitude: 95 

 

 
Figure 1.3 Overview of selected MODIS data coverage 

 

 

Coverage Selection 

Day (containing day data only) 

 

Clicking on Search, the search should find two images having the following names on 

your screen after some time:  

 

MOD021KM.A2008186.0430.005.2010188194504.hdf 

MOD03.A2008186.0430.005.2008186113434.hdf 

 

Note that July 4, 2008 is day-of-year 186. 

 

Note: You can preview the scenes by clicking View RGB.  

 

Clicking on Order Files Now, providing your e-mail address, and checking FTP pull 

option, and then clicking “Order”. 

 

After this is done you will receive an e-mail informing you that your order has been 

received. Within some time (it may take several hours, or one or two days), you will 

receive an e-mail with FTP details, with which you can download the data.  

 

Sometimes it can take quite some time to order the data. If you have no access to the 

Internet, use the files provided in the working directory during exercise, and go 

immediately to the exercise 1.3.   

 

1.3 Getting familiar with the MODIS data with HDFView tool 

 

 Run HDFView 
You can run the HDFView from 
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Start->Program Files->HDFView2.9  

 

 Open a file: 

You can either click the “open” button or select the “open” from the file menu. In the 

Open file pop up window, navigate to the directory containing the downloaded MODIS 

files, choose this file MOD021KM.A2008186.0430.005.2010188194504.hdf 

After that, the structure of the file is displayed in the tree panel on the left side of the 

HDFView Window.    

 

 View data content: 

First double click on “MODIS_SWATH_Type_L1B”, and then double click on “Data 

Fields”, after that, a list of available data fields will appear (see picture below). 

 

 
 

Figure 1.4 Overview of the tree panel of the Main Window 
 

 Obtain the calibration parameters from the HDF file: 

To view the attributes/metadata of the data fields, you can right click on an individual 

field e.g. EV_250_Agg1km_RefSB, in the context-menu, then select “Show Properties” 

menu, then in the pop up window, click on Attributes tab. The following figure shows an 

example of the information for the selected data field.  
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                     Figure 1.5 Overview of attributes of the selected data field 
 

Take some time to examine the data attributes of the different data fields (e.g. band names, 

reflectance/radiance scales, reflectance/radiance offsets, valid range etc.). 

 

There is very import information available in the header of the HDF file. This information is 

relevant for the processing of the MODIS images and need to be exacted.     

 Find out the calibration parameters (reflectance scale and offset) for the 

following bands in this table: 

 

Band name Reflectance scale Reflectance offset 

Band1   

Band2   

Band3   

Band4   

Band5   

Band6   

Band7   
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 Find out the calibration parameters (radiance scale and offset) for the 

following bands in this table:   

     

Band name Radiance scale Radiance offset 

Band2   

Band17   

Band18   

Band19   

Band31   

Band32   

  

The calibration parameters will be used to calculate the reflectance and radiance products 

of the MODIS imagery in exercise 2.     

 

Listing of the MODIS data fields and its corresponding MODIS bands used in this 

exercise in the MOD021KM product 

 

Data Field Band 

EV_250_Aggr1km_RefSB 1,2 

EV_500_Aggr1km_RefSB 3,4,5,6,7 

EV_1KM_RefSB 17,18,19 

EV_1KM_Emissive 31,32 

 

   

 View the Geolocation file: 
 

Click the “open” command button, in the Open file pop up window, choose this file 

MOD03.A2008186.0430.005.2008186113434.hdf 

Follow the above steps to find out the scale factors for the SensorZenith, SensorAzimuth, 

Solarzenith, SolarAzimuth and Height bands. 

 

 

Data Field Scale offset 

SensorZenith   

SensorAzimuth   

Solarzenith   

SolarAzimuth   

 

 

 Close the HDFview program.
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Exercise 2: Processing MODIS Level 1B data for SEBS in 

ILWIS 

2.1 Introduction 

 

SEBS for ILWIS provides a set of routine for bio-geophysical parameter retrievals. It uses 

satellite earth observation data, in combination with meteorological information as inputs, to 

retrieve a set of geo-physical parameters, evaporative fraction, net radiation, and soil heat flux 

parameters etc. This exercise will guide you through the process of estimation of land surface 

geophysical parameters and energy balance components, including evaporation rate. The 

process consists of four main sub-processes: image reprojection, image import, pre-

processing, and the direct SEBS model application 

 

It concerns the files over the Naqu site on the Tibetan plateau, China: 

 

In this exercise, we will be using the following MODIS files: 

- MODIS calibrated L1B swath product: 
- MODIS L1B file MOD021KM.A2008186.0430.005.2010188194504.hdf 

And its corresponding geolocation L1A product: 

MOD03.A2008186.0430.005.2008186113434.hdf, 

Corresponding to an overpass on July the 4th 2008 (Julian day186), recorded at 04:30  GMT.   

The MODIS Level-1B and L1A Geolocation (the MOD03, for Terra, and MYD03, for Aqua) 

products are usually available through the GSFC DAAC website  

http://ladsweb.nascom.nasa.gov/browse_images.  

The following MODIS bands will be extracted and pre-processed for further SEBS sub-

process. 

 From the MODIS L1b file (MOD021KM.A2008186.0430.005.2010188194504.hdf):  

- bands 1 and 2 from the EV_250_Aggr1km_RefSB  data field,  

- bands 3, 4, 5, 6 and 7 from the EV_500_Aggr1km_RefSB data field, 

- bands 17,18 and 19 from the  EV_1km_RefSB data field 

- bands 31 and 32 from the EV_1KM_Emissive data field. 

 From the Geolocation file (MOD03.A2008186.0430.005.2008186113434.hdf ):  

-   Height,  

-   SensorAzimuth,  

-   SensorZenith,  

-   SolarAzimuth and, 

-   SolarZenith.       

 

2.2 Install ILWIS and Sentinel-3 toolbox 

 
We will need to install the ILWIS and Sentinel-3 toolbox for further data processing and 

analysis. 

 

ILWIS 
ILWIS is a remote sensing and GIS software, which can be downloaded from  
http://52north.org/downloads/category/10-ilwis/ 

 

If it is not installed already, install the package as follows: 

http://www.hdfgroup.org/hdf-java-html/hdfview/
http://www.hdfgroup.org/hdf-java-html/hdfview/
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 Type setup.exe to install 

 Start from Start -> programs -> ILWIS  

 

Sentinel-3 toolbox 

 Down and install the Sentinel-3 toolbox software (Please visit 

https://earth.esa.int/web/sentinel-tbx/)   

2.3 Main Processing Steps 

 

There are 4 main processing steps: 

 Reprojecting & converting MODIS level-1B data using ModisSwathTool 

software 

 Importing MODIS images into ILWIS 

 Pre-processing for SEBS    

- Raw to radiance/reflectance 

- Brightness temperature computation 

- Water vapor content estimation 

- SMAC for atmospheric correction   

- Land surface albedo computation 

- Land surface emissivity, NDVI, and vegetation proportion difference 

computation 

- Land surface temperature computation 

 Appling SEBS model for estimation of evapotranspiration  

- Input of the meteorological information 

- Input of the satellite observation data 

- SEBS computation 

- Verification the outputs and comment  

 
Figure 2.1 below shows a simplified flowchart for these steps. 
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Figure 2.1 Simplified flowchart - Processing of MODIS L1B for SEBS 

 

2.3.1 Step I: Reprojecting MODIS Level-1B Data   

 

The MODIS L1B data are in swath (orbit based) format, therefore in this part, we need to 

reproject the data to a standard projection and format compatible with GIS software.  

The MODIS Reprojection Swath Tool (ModisSwathTool) allows the user to transform 

MODIS L1B data from swath format to other widely supported projections and formats for 

GIS applications.  

 

For the current exercise, both the MODIS Level-1B and geolocation products should be 

converted to TIFF/GeoTIFF format, and reprojected to the Geographic projection ready for 

importing into ILWIS.   

 

The procedure with ModisSwathTool software is as follows:  
 

Start MRTSwath program with ModisSwathTool.bat from the D:\MRTSwath\bin directory, or 

to create a shortcut to MRTSwath, and click on the shortcut 
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Figure 2.2 Example for the settings in the ModisSwthTool 

 

a) Converting desired channels in the MODIS level-1B file into GeoTIFF   

 Click on the “Open Input File” button to the right of the Input file field, and then 

select the desired input file, in this case,  

MOD021KM.A2008186.0430.005.2010188194504.hdf from the input file selection 

dialog box.  

 Select the desired bands to process. By default, all the available bands in the input file 

are selected. In this exercise we wish to extract the following bands: 

 EV_250_Aggr1km_RefSB_b0 - channel 1 

 EV_250_Aggr1km_RefSB_b1 - channel 2 

 EV_500_Aggr1km_RefSB_b0 - channel 3 

 EV_500_Aggr1km_RefSB_b1 - channel 4 

 EV_500_Aggr1km_RefSB_b2 - channel 5 

 EV_500_Aggr1km_RefSB_b3 - channel 6 

 EV_500_Aggr1km_RefSB_b4 - channel 7 

 EV_1km_ RefSB_b11 - channel 17 

 EV_1km_ RefSB_b12 - channel 18 

 EV_1km_ RefSB_b13 - channel 19 

 EV_1KM_Emissive_b10 – channel 31 

 EV_1KM_Emissive_b11 – channel 32 

      

 Select Input Lat/Lon from the spatial subset field.   



  

13 

 Enter the upper left and lower right corner coordinates in the Latitude and Longitude 

to cut the area of interest, in this case the coordinates are filled with following 

coordinates:  

 UL Lat 19  

 UL Long 97 

 LR Lat 7 

 LR Long 110 

 Select the associated Geolocation file corresponding to the MODIS L1b swath file.  

Note: This file needs to be of the same date and time as the input MODIS swath file, 

otherwise the Geolocation data will be incorrect. 

 Input the output file by 

clicking the “Specify 

output file” button. In the 

output file dialog box, 

type in .tif for the output 

file as shown right. Make 

sure the data is stored in 

the proper output folder. 

Tip: The output band name is 

automatically appended to the 

base output file name, in this 

case, 

_EV_250_Aggr1km_RefSB_b0.t

if for band1 and 

_EV_250_Aggr1km_RefSB_b1.t

if for band2, respectively. 

 Select GeoTIFF format 

from the output File 

Type.  

 Change the resample method to Nearest Neighbor 

 Select the Output Projection Type to Geographic 

 Leave the default the same as input data types for the Output Data Type 

 Set the output pixel sizes to 0.01 degree 

 Press Run to complete the data conversion process. Note that a window will appear 

that shows the processing status of the process.  

 

 Why do you think that the pixel size of 0.01 degree was selected? 
 

b) Converting satellite and solar zenith and azimuth angles into GeoTIFF  
 

 Open the geolocation file MOD03.A2004186.1045.005.2007287062243.hdf. Select 

bands SolarZenith, SolarAzimuth, SensorAzimuth, SensorZenith and Height. 

 Specify the file extension .tif for the output filename in the Select File dialog. 

 Specify the other input parameters as same as those used for the MODIS L1B file 

(see figure 2.4 below).  

After this processing finished, you will obtain GeoTIFF files:  

_SolarZenith,  

_SolarAzimuth 

_SensorAzimuth,  

_SensorZenith  

_Height 

 

 
Figure 2.3: Output file selection dialog box, the 

extension you choose .tif (Tagged Image File 

Format TIFF) will determine the output file 

format. 
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Figure 2.4 Example window for the setting to the Geolocation file 

 

Upon completion the process of data processing, close the ModisSwathTool and start ILWIS. 

 

At this point: ILWIS should be installed.  

 

2.3.2 Step II: Importing MODIS files into ILWIS 

a) Start ILWIS and navigate to the directory where the MODIS GeoTIFF files are 

located.  

 Go to the ILWIS menu File-Import to open the ILWIS Import tool. 

 Select Geospatial Data Abstraction Library (GDAL) option. 

 Select raster->GEOTIFF format.    

 Click on the “Open Input File” button to the right of the Input file field, and 

then select the desired input tif file, e.g.  _EV_250_Aggr1km_RefSB_b0.tif 

from the input file selection dialog box.  

 Uncheck the “Output name matches input” check box, input output filename 

(band1_dn). 

 Clean the “Use as” check box to import as ILWIS raster files and proceed to 

import (see figure 2.5 below).   

After that, you will find a new ILWIS collection (named band1_dn), which assigned 

automatically a name based on the output filename. The ILWIS collection contains 

the ILWIS objects.  
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Figure 2.5 Import MODIS bands into ILWIS screen 

 

Open the collection by double clicking on it (see Figure 2.6), Open the image to 

understand parameter value ranges, image size and resolution (right click on the map, 

select “Properties”. 

The raster map (named for example band1_dn) is 

assigned automatically a georeference and a coordinate 

system respectively. Check also the gereference and the 

coordinate system objects.    
 

Repeat the import steps above for each of the MODIS files 

(in GeoTIFF format).  

 

Verify that all images have been correctly imported (check 

the coordinate system and georeference) 

 

 
Figure 2.6 Object collection 

after importing 
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Table 1: GeoTIFF files used in this exercise 

Input GeoTIFF filename Output Filename in ILWIS  

_EV_250_Aggr1km_RefSB_b0.tif Band1_dn 

_EV_250_Aggr1km_RefSB_b1.tif Band2_dn 

_EV_500_Aggr1km_RefSB_b0.tif Band3_dn 

_EV_500_Aggr1km_RefSB_b1.tif Band4_dn 

_EV_500_Aggr1km_RefSB_b2.tif Band5_dn 

_EV_500_Aggr1km_RefSB_b3.tif Band6_dn 

_EV_500_Aggr1km_RefSB_b4.tif Band7_dn 

_EV_1KM_RefSB_b11.tif Band17_dn 

_EV_1KM_RefSB_b12.tif Band18_dn 

_EV_1KM_RefSB_b13.tif Band19_dn 

_EV_1KM_Emissive_b10.tif Band31_dn 

_EV_1KM_Emissive_b11.tif Band32_dn 

_SolarZenith.tif sza_dn 

_SolarAzimuth.tif saa_dn 

_SensorAzimuth.tif vaa_dn 

_SensorZenith.tif vza_dn 

_Height.tif Height 

 

 

 Open some maps and check the values. What are the units? 

 

b) In order to import all the files in a faster way, you can create an ILWIS 

script and run it: 

 

 Select File menu > Create menu > Script … 

A new script window will be opened. 

 Go to the main ILWIS window, click on the arrow on upper right of the 

window to have a view on the command history. 

 Look for the line starting with “open” and end with “-method=GDAL –

import” (which is the ILWIS command to import data via GDAL). Click and 

copy the command line. 

 Paste the command line in the new script window (as shown in Figure 2.7). 

Repeat this step 17 times in order to have 17 command lines in the new script. 

 Change the name of input and output file in order to run the import command 

on all the MODIS GEOTIFF files. (See the red circles in Figure 2.7) 

 Save the new script. 

 To run the new script, click on “Run Script” button (see the red circle). 

After these steps, you will see the complete list of output ILWIS collections in the 

Catalog shown in the main window of ILWIS.  

Open images to understand parameter range, image size and spatial resolution.  

Identify how many images belong to the visible, near infrared, and thermal?  
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Figure 2.7 How to create a script to import MODIS GEOTIFF files used in this exercises 

2.3.3 Step III: MODIS Pre-processing for SEBS 

 

Raw to radiances/reflectance (MODIS) 
 

The MODIS Level 1b data are given in digital numbers, therefore, once imported into ILWIS, 

DNs bands must be converted to reflectances (for  bands 1 to 7) and radiances (for bands 2, 

31,32, 17,18 and 19). The SEBS for ILWIS provides the tools to convert the imported 

MODIS bands in the digital numbers to the radiances and the reflectance.  

The process is similar for all bands. Calibration coefficients (scale and offset) are provided in 

the HDF header file and are extracted in the previous exercise for each band. Please use them.   

          

 Select Operations-SEBS Tools- Pre-processing - Raw data into radiances/reflectance 

(MODIS) 

 Select input data file   

 Provide the scale and offset values for radiance/reflectance correction 

 Assign a proper name for the output file.  

 Click on Show, an ILWIS raster file in radiance/reflectance will be created and 

opened.  

 Have a look at it, and then close it.  

 Repeat the same procedure for the other bands.  

 

Note: bands 1 to 7 need to be corrected by the reflectance scales and offsets; while bands 2, 

17, 18, 19, 31 and 32 need to be converted by applying radiance scales (8.40022E-4, 

7.296976E-4) and offsets (1577.3397, 1658.2212) respectively in this case. 
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Figure 2.7 Example for converting band1 into reflectance 

dialog box 

 
Figure 2.8 Example for converting band31 into 

radiances dialog box 

 

 

The equation for calculation of reflectance and radiance as follows: 

reflectance = reflectance_scale ( DN – reflectance_offset)  

radiance = radiance_scale ( DN – radiance_offset)  

 

The calculation also can be done using the ILWIS map calculator or command line.  You 

could use a script to do it. 

The following script in ILWIS will calculate the reflectance and radiance of all MODIS 

bands: 

 

band1_ref.mpr := MapSI2Radiance(band1_dn,5.6184363E-5,0.0000000000) 

band2_ref.mpr := MapSI2Radiance(band2_dn,3.371625E-5,0.0000000000) 

band3_ref.mpr := MapSI2Radiance(band3_dn,5.6763303E-5,0.0000000000) 

band4_ref.mpr := MapSI2Radiance(band4_dn,4.6312645E-5,0.0000000000) 

band5_ref.mpr := MapSI2Radiance(band5_dn,4.110393E-5,0.0000000000) 

band6_ref.mpr := MapSI2Radiance(band6_dn,3.6677564E-5,0.0000000000) 

band7_ref.mpr := MapSI2Radiance(band7_dn,3.031405E-5,0.0000000000) 

 

band2_rad.mpr := MapSI2Radiance(band2_dn,0.010334734,0.0000000000) 

band17_rad.mpr := MapSI2Radiance(band17_dn,0.0037166378,316.9722) 

band18_rad.mpr := MapSI2Radiance(band18_dn,0.003564576,316.9722) 

band19_rad.mpr := MapSI2Radiance(band19_dn,0.001125143,316.9722) 

band31_rad.mpr := MapSI2Radiance(band31_dn,8.40022E-4,1577.3397) 

band32_rad.mpr := MapSI2Radiance(band32_dn,7.296976E-4,1658.2212)   

   

The next step is the re-scaling of the zenith and azimuth angle maps: 

Note: in this case all solar and satellite zenith and azimuth angles need to be re-scaled by 

multiplying maps with a scale factor 0.01; this operation can be done 4 times, one for each 

map, using the ILWIS map calculator or applying the following formulas in the command 

line. e.g.: 

sza = sza_dn * 0.01  

saa = saa_dn * 0.01 

vza = vza_dn * 0.01 

vaa = vaa_dn * 0.01 

 

Open the SZA and the SAA maps and verify the minimum and maximum values and fill the 

following table. Units should be in degrees  

 

 SZA SAA 

Min   

Max   
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Brightness temperature computation 
 

This procedure provides the option to convert the bands 31 and 32 of MODIS from radiance 

to blackbody temperatures. The conversion is done by applying the well-known Planck 

equation 

 

 
  c1 and c2 are blackbody constant. 

 

 Select Operations -> SEBS Tools -

> Pre-processing  > Brightness 

temperature computation 

 Select MODIS sensor  

 Select input radiance bands 31 and 

32   

 Specify a proper name for the 

output files, for example btm31 and 

btm32 for bands 31 and 32 

respectively.  

 Click on Show to start computing. 

 
 

 

  

 

 

Open the reflectance map in channels 1 to 7 and select a water, a soil and a vegetated pixel 

and fill the following table with reflectances: 

 

 Water Vegetation Soil 

Lat, long:       

Channel 1    

Channel 2    

Channel 3    

Channel 4    

Channel 5    

Channel 6    

Channel 7    

 

These will be the reflectance before atmospheric correction. 

For the same pixels find out the Brightness temperature in channels 31 and 32. 

 

 BT 31 BT32 

Water   

Soil   

Vegetation   

 

 
Figure 2.9 Computing brightness temperature for 

band 31 and 32 user interface 
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Water vapour content estimation 

 
Water vapour content is estimated using the radiance values of MODIS bands 2, 17, 18, and 

19.  

The procedure for water vapor estimation is as follows: 

 Select Operations-SEBS Tools-

Pr 

 e-processing-Water vapor 

computation 

 Select input radiance bands 

 Specify a proper name for the 

output file 

 Click on Show to start 

computing 

 

At the end of this step all input maps are 

ready for the atmospheric correction 

process. 

 

 

 

 

 

 

 

 

Atmospheric Correction (SMAC) 
 

The correction of the atmospheric absorption and scattering in the visible channels is essential 

for any approach dealing with the energy balance equation. If atmospherically corrected maps 

are already available they can be imported into the ILWIS and this step can be skipped. 

 

SMAC is a tool for the atmospheric effect correction of the visible and near visible bands of 

different sensors e.g. MODIS, ASTER, MERIS, NOAA, SPOT, and AATSR. The algorithm 

by Rahman H., Dedieu G. (1994). is used. 

 

SMAC requires information of the atmospheric composition at the moment the satellite 

passes and information of the geometry of the satellite and sun. 

 

IMPORTANT NOTE: According to the authors of SMAC, the model can't be applied for 

solar zenith angles greater than 60 degrees and/or satellite zenith angles greater than 50 

degrees. So be aware on the use of MODIS images in winter time. SEBS4ILWIS is able to 

accept atmospherically corrected maps from external sources, in case other algorithm is used. 

 

The set of input required by SMAC is described below: 

 

Aerosol optical thickness (AOT evaluated at 550 nm wavelength): The value ranges from 

0.05 to 0.8. Aerosol in the atmosphere has an extreme dynamic behaviour. As a reference 

aerosol conditions may change in time scales less than an hour with high spatial variation. At 

such it is difficult to get accurate information on the aerosol optical thickness. 

 

 
Figure 2.10 Example settings in Water Vapor 

computation 
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Use could be made of the aeronet service http://aeronet.gsfc.nasa.gov/  (that might help to 

evaluate a reasonable value of aerosols in case that a station is located close to the area of 

interest). 

 

By exploring the Aeronet site information of the kind showed in the graph below can be 

retrieved for the sunphotometer stations closest to the area of interest and at the time of the 

image. 

 

 
Figure 2.11 AOT is evaluated from sunphotometers at different wavelengths. The vertical line 

in the previous figure indicates the satellite pass 

 

 Go to the study area (Naqu site on the Tibetan plateau, China), derive the 

AOT value 

Tip: in case you do not have enough time to complete the exercise, please use the AOZ 

provided you in the table below. 

     

Ozone content: Ozone can be also measured in DU (Dobson Units. 1000 DU = 1 g.atm.cm). 

Ozone content is less dynamic than the AOT component (changes during days or weeks).  

 

Ozone is monitored quite intensively from satellites and other ground resources. 

A good source of ozone on the internet is http://macuv.gsfc.nasa.gov/. Use TIFF high 

resolution on the same date. Earth-Probe sensor.  

http://aeronet.gsfc.nasa.gov/
http://macuv.gsfc.nasa.gov/
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In this exercise, we will use some fixed values, but it is important to realize that these 

atmospheric composition has to be evaluated by the time, site and conditions of the 

imagery.  
AOT 550 nm 0.3 

Ozone content [atm.cm] 0.288 

Surface pressure [HPa] 592 

Water vapour(grams. cm
-2)

 map 

 

 

The procedure for SMAC is as follows: 
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 Select Operations -> SEBS 

Tools -> Pre-processing –> 

SMAC  

 Top atom. reflectance 

channel: Select an input 

reflectance in VIS or NIR as it 

was calculated above. The 

process will be repeated for 

all VIS and NIR maps.     

 Coefficient file for sensor: 
Select a coefficient file that 

contains calibration needed 

for the SMAC algorithm. The 

coefficients are calculated for 

only two atmospheres:  desert 

and continental.   SMAC 

model has in-built standard 

coefficients for different 

sensors e.g. MODIS, AATSR, 

MERIS, NOAA, SPOT and 

two atmospheres (desert and continental). SMAC for ILWIS allows the user to select 

from a list.  

 Optical thickness map: Check the option when you wish to use a map that contains 

optical thickness (depth) values. Otherwise type a constant value that will be applied 

to all pixels. The value range is between 0.05 to 0.8. The value of the optical depth at 

550nm is needed in SMAC.  

 Water vapor content map: It refers to the total column of water. Check the option 

when you wish to use a map for water vapor values. Otherwise type a constant value 

that will be applied to the entire image. The unit of the value is grams. cm
-2

, and the 

value range is between 0.0 to 6.0 

 Ozone content map: Check the option when you wish to use a map containing ozone 

content values. Otherwise provide a constant value that will be applied to the entire 

image. The unit of it is gram. atm. cm, and the value range is 0.0 to 0.7. 

 Surface pressure map: Check the option when you wish to use a map that contains 

surface pressure values. Otherwise provide a constant value for all pixels. The unit of 

the value is hpa (Hecto Pascal or millibars). 

 Solar zenith angle map: Check the option when you wish to use a map that contains 

solar zenith angle values. Otherwise type a value for all pixels. Unit is degree.   

 Solar azimuth angle map: Check the option when you wish to use a map that 

contains solar azimuth angle values. Otherwise type a value for all pixels. Unit is 

degree.   

 Sensor zenith angle map:  Check the option when you wish to use a map that 

contains satellite azimuth angle values. Otherwise type a value for all pixels. Unit is 

degree.   

 Sensor azimuth angle map: Check the option when you wish to use a map that 

contains satellite azimuth angle values. Otherwise type a value for all pixels. Unit is 

degree.   

 Output raster map:  Type a name for the output raster map. 

 
In this exercise, the procedure of atmospheric correction needs to be repeated seven times 

(one for each visible channel).  In the end the interface should look like as shown in Figure 

2.12 (values are only example in there, you need to use your own data) 

 

 
Figure 2.12 Example settings in Atmospheric correction 

for MODIS band1 
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Note that in order to correct all the images in a faster way, you can create an ILWIS script to 

do so. None of the atmospheric or geometric parameters change when doing all other bands. 

You must change the reflectance map and the coefficient file for the sensor and band in 

question!! 

 

Land surface albedo computation 
 

The surface albedo can be computed as follows: 

Using MODIS reflectance bands 1, 2, 3, 4, 5 and7, the formula by Liang et al., 2001, 2003 is 

used: 

albedo = 0.160*r1 + 0.291*r2 + 0.243*r3 + 0.116*r4 + 0.112*r5+0.018*r7 – 0.0015 

Where, r1, r2, r3, r4, r5, r7 are the MODIS surface reflectance bands. 

 

The procedure for land surface albedo calculation is as follows: 

  

 

 Select Operations -> SEBS Pre-

processing –> Land Surface 

Albedo Computation 

 Select sensor type MODIS  

 Provide the input bands. (surface 

reflectance maps that are the output 

of a previous SMAC operation)  

 Assign a proper name for the 

output file 

 Click on Show to start computing. 

 

 

  

  

  

Tip: A second way of calculating the 

albedo is type the equation directly in the Map Calculation or ILWIS command line 

 Display the albedo map and check the values for the same pixels as before: 

 

 Albedo 

Water  

Soil  

Vegetation  

 

 

Land surface emissivity computation 
 

The Land surface emissivity computation operation is used to produce the surface emissivity 

using the atmospherically corrected surface reflectance in the red and NIR bands (Sobrino et 

al, 2003).  

This method is restricted to land pixels. The emissivity for water pixels has been assigned a 

value of 0.995. Here assume that an albedo value < 0.035. You can try  other discretization 

methods. 

 

The NDVI values will be calculated with the equation based on the atmospherically corrected 

surface reflectances as shown below: 

 
Figure 2.13 Computing surface albedo  
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NDVI = (Bnir-Bred)/(Bred+Bnir) 

The algorithm considers three different types of pixels depending on the NDVI value:  

 

 for bare soil pixels, NDVI < 0.2   

Emissivity e = 0.9832 – 0.058 * Bred  

Emissivity difference de = 0.0018 – 0.06 * Bred 

 

 for mixed pixels  0.2 =< NDVI < = 0.5  

Emissivity e = 0.971 + 0.018 * Pv  

Emissivity difference de = 0.006 * (1 – Pv) 

 

 for vegetation pixels NDVI > 0.5  

Emissivity e = 0.990 +de 

Emissivity difference de = 0.005 

     

A vegetation proportion Pv is given by: 

Pv = (NDVI – NDVImin)^2 / (NDVImax – NDVImin)^2     

Where, NDVImax = 0.5 and NDVImin = 0.2. 

Optionally, you can also obtain the following surface parameters as outputs 

- NDVI 

- Spectral emissivity difference 

- vegetation proportion  

 

 Display the emissivity and NDVI maps and check the values for the same 

pixels as before: 

 

 NDVI Emissivity 

Water   

Soil   

Vegetation   

 

 

The procedure for land surface 

emissivity calculation is as follows: 

 

 Select Operations -> SEBS Pre-

processing –> Land Surface 

Emissivity Computation 

 Select Sensor type MODIS 

 Select the visible and near 

infrared atmospherically 

corrected reflectance bands, 

which are derived from the 

previous SMAC operation for 

MODIS bands 1 and 2.   

 Optionally, select an albedo 

map, if available.      

 Assign a proper name for the 

output file  

 Optionally, select Create NDVI map check box to obtain a NDVI map 

 
Figure 2.14 Computing surface emissivity dialog 

box 
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 Optionally, select Create emissivity difference map check box to obtain an emissivity 

difference map. 

 Optionally, select Create Vegetation Proportion map check box to obtain the 

vegetation proportion map. 

 Click on Show to start computing. 

 

Land surface temperature computation 

 
This operation computes the land surface temperature using a split window method. The 

equation is shown below: 

 

LST = btm31+1.02+1.79*(btm31-btm32) +1.2*(btm31 - btm32)^2+ 

  (34.83-0.68*W) *(1-e)+ (-73.27-5.19*W)*de 

Where:  

LST – Land surface temperature 

btm31 – brightness temperature obtained from MODIS band 31 using a previous 

Brightness temperature computation operation 

btm32 – brightness temperature obtained from MODIS band 32 using a previous 

Brightness temperature computation operation 

W – Water vapor content 

e – Surface emissivity   

de – Surface emissivity difference 

 

 

If the water vapor map is not available, 

the simplified formula as shown below 

will be used: 

LST = btm31+1.02+1.79*(btm31-

btm32) +1.2*(btm31 - btm32)^2  

 

The procedure for land surface 

temperature (LST) calculation is as 

follows: 

 Select Operations -> SEBS Pre-

processing –> Land Surface 

Temperature Computation 

 Select Sensor type MODIS 

 Select brightness temperature 

bands 31 and 32 of MODIS 

obtained from a previous 

Brightness computation 

operation.   

 Optionally, select a map that 

contains water vapor content 

values.      

 Assign a proper name for the 

output file  

 Click on Show to start computing. 

 Display the surface temperature map and check the values for the same 

pixels as before: 
 

 LST 

Water  

 
Figure 2.15 Land surface temperature calculation 

dialog window 
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Soil  

Vegetation  

 

2.3.4 Step VI: SEBS (Surface Energy Balance System) 

 

The SEBS (Su, 2002) operation estimates the radiation balance components, atmospheric 

turbulent fluxes, surface evaporative fraction, and daily evaporation etc. using remote sensing 

observation in combination with the meteorological measurements.  

In this exercise, you will be using the land surface parameter maps (e.g. land surface 

temperature, land surface albedo, NDVI, land surface emissivity) derived from the previous 

exercise and the meteorological data (specific humidity, wind speed, air temperature, and air 

pressure) will be extracted from GLDAS (Global Land Data Assimilation System) for forcing 

the SEBS model. Meteorological data from other analysis and prediction systems, e.g. 

ECMWF, NCEP, can be used equally.   

GLDAS data can be accessed via NASA DISC Hydrology Data and Information Services 

Centre (HDISC) from the internet at the following address: 

http://disc.sci.gsfc.nasa.gov/hydrology/data-holdings 

 

It concerns the file: GLDAS_NOAH025SUBP_3H.A2008186.0300.001.2008296215855.nc 

3 hourly 0.25 degree Experiment 1 GLDAS-1 Noah data, recorded at 03:00, on July the 4th 

2008 (Julian day186) in netCDF format. 

For the current exercise, the GLDAS file with global coverage has been already downloaded 

and provided to you in the same folder of the other data. 

We will need to extract the following bands and import them into ILWIS: 

 Air temperature (K)) 

 Air pressure (Pa) 

 Specific humidity (kg/kg) 

 Wind speed (m/s) 

First, Sentinel-3 toolbox will be used to convert the HDF images into the GEOTIFF files:  

Sentinel-3 toolbox -part: 

 Go to the menu File -> Open Products... to open the GLDAS file    

 After that, a list of available bands will appear, double click at least one of the listed 

images.  

 Check the description and unit of the bands: Qair, Wind, Tair, PSurf  

 What are the units for the above bands?   

 After that, go to menu File -> Export->Export to GEOTIFF Product... 

 Close the toolbox. 

 

Note that you can keep the default settings in the output dialog box.  

http://disc.sci.gsfc.nasa.gov/hydrology/data-holdings
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ILWIS-part: 

Import the GLDAS files to ILWIS 

 Import the TIFF files into ILWIS. After this step you will obtain a new maplist for all 

GLDAS bands, and the band names are automatically numbered from 1 to 28.   

 Note that the bands from 25 to 28 will be used for the present exercise, which 

correspond to the specific humidity (kg/kg), the wind speed (m/s), the air temperature 

(K) and the surface pressure (Pa) maps respectively. 

 Change the maplist georeference to GLDAS provided.  
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 Mirror/Rotate maps: Reflect line 

numbers in a horizontal line. 

Select Mirror Rotate operation. The input 

raster map is the GLDAS band e.g. 

LDAS_files_band25 (specific humidity, see 

figure 16).  After the map is rotated, 

change the georefference of the mirrored 

map to GLDAS. Repeat the Mirror Rotate 

operation for other 3 GLDAS files.   

 Resample the GLDAS images from 

0.25 degree spatial resolution to 

MODIS (1km) scale.  

Go to Spatial Reference Operations -> 

Resample. This step needs to be repeated 4 

times (one for each required GLDAS file)  

 

 

 

 

 

 

You could use a script to do it. The following script in ILWIS will carry out the Rotate 

operation.  

 

Qair_g.mpr := MapMirrorRotate(GLDAS_files__25,MirrHor) 

calc Qair_g.mpr 

setgrf Qair_g.mpr gldas.grf 

Qair:=iff(Qair_g.mpr<=1.00000e20,Qair_g,?) 

Wind_g.mpr := MapMirrorRotate(GLDAS_files__26,MirrHor) 

calc Wind_g.mpr 

setgrf Wind_g.mpr gldas.grf 

Wind:=iff(Wind_g.mpr<=1.00000e20,Wind_g,?) 

Tair_g.mpr := MapMirrorRotate(GLDAS_files__27,MirrHor) 

calc Tair_g.mpr 

setgrf Tair_g.mpr gldas.grf 

Tair_K:=iff(Tair_g.mpr<=1.00000e20,Tair_g,?) 

Tair:=Tair_K-273 

Psurf_g.mpr := MapMirrorRotate(GLDAS_files__28,MirrHor) 

calc Psurf_g.mpr 

setgrf Psurf_g.mpr gldas.grf 

Psurf:=iff(Psurf_g.mpr<=1.00000e20,Psurf_g,?) 

 

The following script in ILWIS will carry out the Resample operation.  

 

Qair_rs.mpr:= MapResample(Qair,band1_dn.grf,bilinear) 

Tair_rs.mpr:= MapResample(Tair,band1_dn.grf,bilinear) 

Wind_rs.mpr:= MapResample(Wind,band1_dn.grf,bilinear) 

Psurf_rs.mpr:= MapResample(Psurf,band1_dn.grf,bilinear) 

calc Qair_rs.mpr 

calc Tair_rs 

calc Wind_rs.mpr 

calc Psurf_rs.mpr 

 

After that, the following maps will be created: 

 
Figure 16: Mirror Rotate map 
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Map Description 

Tair_rs Air temperature (K) 

Wind_rs Wind speed (m/s) 

Qair_rs Specific humidity (kg/kg) 

Psurf_rs  Air pressure (Pa) 

 

SEBS estimates roughness height either using field observations and literature values from a 

look-up table associated to a land-use map, or using empirical equations with NDVI values, 

when the filed observations/literature values are not available.         

 

You can start SEBS from Operation –> SEBS Tools -> SEBS    

 

  

 
Figure 2.16 Example: SEBS operation user interface. 

   

 

Land surface temperature map: Select an input map that contains land surface 

temperature values; In this case, select lst derived from a previous Land surface 

temperature computation operation. 

Emissivity map: Select an input map that contains land surface emissivity values.  

Land Surface Albedo map: Select an input map that contains surface albedo values. 

NDVI map: Select an input map that contains NDVI values. 

Vegetation fraction map: Select this option when you wish to use a map containing 

vegetation fraction (proportion) values. 

Leaf Area Index map: Select this option when you wish to use a map containing leaf 

area index values, if this is not available, empirical equation with NDVI values is used 

to estimate the LAI. MODIS products also contain LAI product. The data is almost 

compulsory for a real case because the validity of empirical equations is mostly site 

limited. For the exercise leave the data blank. 
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Sun zenith angle map: Check the option when you wish to use a map containing sun 

zenith angle (Select sza in this case). Otherwise type a sun zenith angle value that will 

be applied to all pixels.     

DEM map: Check the option when you wish to use a digital elevation map (Select 

height in this case). Otherwise type a height value that will be applied to all pixels.  

Downward Solar radiation map: Select this option if you wish to use a map 

containing downward solar radiation. The user is entitled to build the map, which uses 

the same georeference to all other maps.   

Downward Solar radiation: Select this option to type a downward solar radiation 

value to be applied to the whole study area;  

The solar radiation is a very important variable and it is highly recommended for its 

direct input with a map or an actual value. If both a map and a actual value are not 

available, the horizontal visibility will be used in SEBS as surrogate for the 

calculation of the incoming shortwave radiation needed in the SEBS equation.      

Horizontal visibility: Type a value for the horizontal visibility in kilometers. Enter 

39.20. The user interface will not use this value if the shortwave radiation map/value 

is entered. 

Canopy height map: Select this option to calculate SEBS results with the canopy 

height values (hc) from the attribute table associated to a land-use map. Otherwise, 

empirical equations for the calculation of canopy height values are used. For 

additional information over the attribute table, refer to the figure below.   

Displacement height map: Select this option when you wish to calculate SEBS 

results with the displacement height values (d0) from the attribute table associated to 

a land-use map. Otherwise, empirical equations for the calculation of the 

displacement height values are used. 

Roughness height map: Select this option when you wish to calculate SEBS results 

with the roughness height values (z0m) from the table associated to a land-use map. 

Otherwise, empirical equations for the calculation of the roughness height values are 

used. 

For options 11, 12 and 13, leave the uncheck box. For the sake of time concerns, we 

will not calculate the landuse map (normally very much needed). Leaving the uncheck 

boxes will trigger a routine to calculate these values. This is not adequate for a proper 

real case!!! 

Julian day number: Select this option to type a Julian day number. Unselect the 

option if you wish to use the routine in SEBS to obtain it.    

Reference height:  Type a value for the reference height in meters (at which the 

meteorological variables are measured or computed from a model). Enter 2 m. 

PBL height:  Type a value for the PBL (Planetary Boundary Layer) height in meters. 

Enter 1000 m. 

Humidity map: Select the Check box if you wish to use a map containing humidity 

values. Otherwise type a value for the specific humidity at reference height in kg per 

kg.  

Wind speed map: Select the Check box if you wish to use a map containing wind 

speed. Otherwise type a wind speed value in meters per second. 

Air Temperature map: Select the Check box if you wish to use a map containing air 

temperature measurements. Otherwise type a value of air temperature at reference 

height in degree Celsius.. 

Pressure at reference height map: Select the Check box if you wish to use a map 

containing pressure at reference height. Otherwise type a value for the pressure at 

reference height in Pa.  
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Pressure at surface: Select the Check box if you wish to use a map containing 

pressure at surface. Otherwise type a value for the pressure at surface in Pa.  

Mean daily air temperature map: Select this option to provide a map containing 

mean daily air temperature. Otherwise type a value for the mean daily air temperature. 

Sunshine hours per day: Select this option to provide a sunshine hours/day map. 

Otherwise type a value for the sunshine hours per day. 

kB^-1: Where B^-1 is the inverse Stanton number, a dimensionless heat transfer 

coefficient. Select this option to type a value for kB^-1, otherwise, use the model 

output for the estimation of the kB^-1 in SEBS.     

Output Raster Map: Type a name for the output raster map containing evaporative 

fraction.    
 

 

Figure 2.17 Look-up table associated to a land-use class map containing field 

observations/literature-based surface parameters for canopy height (hc), roughness 

length for momentum transfer (Z0m) and displacement height (d0) 

 

Outputs of SEBS 

After the successful completion of the SEBS operation in ILWIS, you should see the 

following main raster maps in the Current Catalog: 

 

 sebs_ evap: Evaporative fraction  

 sebs_daily_evap: daily evaporation 

 sebs_evap_relative: relative evaporation 

 sebs_G0: Soil heat flux 

 sebs_H_dry: Sensible heat flux at the dry limit 

 sebs_H_i: Sensible heat flux 

 sebs_H_wet: Sensible heat flux at the wet limit 

 sebs_Rn: Net radiation 

 sebs_LE: Latent heat flux 

 

For this exercise, a special version of SEBS4ILWIS is available that also allows seeing some 

intermediate maps like: 

 

 Sebs_LAI: Leaf area index  

 Sebs_z0m: roughness height for momentum transfer (m)  

 Sebs_C_i: Stability corrections  

 Sebs_z0h: scalar roughness height for heat transfer (m) 

 Sebs_T0ta: Difference between LST and air temperature 

 Sebs_kb: kB^-1 value   

 

 Evaluate the results and comment. 
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By now you have successfully completed this exercise. Congratulations! 
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